Trying to learn computer software is often a lot of fun, but as you might know, it can also be frustrating. The element of 3D compounds the challenge in your quest to master a new software application, such as modo 201/202. This adds even more facets to the amount of information you’ll need to absorb to create anything more than a blob of 3D geometry—or so you think! Although Luxology’s modo is an easy-to-use application, it does take a little getting used to. But in the next few pages, you’ll soon see results and you’ll realize that this killer application from Luxology is not as hard to learn as you once thought.

Here’s the deal: I just returned from the bookstore, where I was skimming through the new line of books on various topics. I looked at the Maya books, the Flash books, and the general 3D graphics books. While the information is good, there’s so much talk! Argh! You don’t want that, do you? Granted, you don’t want a “point-and-click” book; rather, you want a book that will help you understand the tools. I first came upon this situation when writing Inside LightWave 8 (New Riders Press, 2003). At the time, I was looking to use Flash more, and all of the books I found talked about the same thing. They all started out the same way, either covering the tools of the interface or having you build silly little character shapes. Somehow it was left to me to sift through 500 pages and then figure out how to make some simple interactive menus.

Because of the frustration I get from most software books, I want my books to help you learn differently. For example, if you were to sit down with me right now in my studio, I’d show you modo. We’d start with a “Hey, check this out!” and a
“Here’s how this works” type of approach. Would you ever sit down in a training session with someone and have that person talk about theory and the history of 3D, and blah, blah, blah? You want to learn the software! Or, what if you went to a trade show to see modo in action. Imagine Luxology’s Brad Peebler sitting there and discussing coordinates, the history of 3D, or principles of lighting. You’d walk. You’d be there to see the software and what it can do. So why should a book on the subject be any different?

To quickly accelerate you from a novice to a somewhat dangerous 3D modeler, I created this “Jump Start” chapter. I designed it to take you through the entire process of creating, surfaced, and rendering a model in modo 201/202 without much effort. Note that this chapter will not discuss in detail workflow, tools, and interface. Rather, it will provide a show-and-tell method of learning that quickly walks you through the necessary steps to gain a keen understanding of the modo 201/202 process. And with that, you’ll be able to work in the program and get results right away. The idea is not to have you read 30 or 40 pages, only to find that you created a ball, moved and rotated it, and copied it to three layers. I know you’re smarter than that!

When you start up modo 201/202, you’re presented with a cool, modern-looking interface, as shown in Figure 4.1.
Model Preparation

If your modo interface does not look like Figure 1.1, be sure you’re using the default interface setting. You can find this setting by going to the very top of your screen and clicking the Layout drop-down menu, navigating to Layouts, and then selecting the modo 201/202 default layout. Figure 4.2 shows the selection.

The project you’ll be working on in this chapter will give you a working knowledge of modo 201/202. You’ll create a cool pair of sunglasses, from the modeling steps through texturing and rendering. Along the way, you’ll get a feel for how to approach most projects in the program.

Figure 4.2
To set your modo 201/202 interface to its natural state (that is, its default settings), choose the default setting from the Layout drop-down menu.

Tip
Although selecting the 201 default layout option appears to reset your viewports to their natural state, there’s a little trick you can do if the interface is not quite right. Select the 201 default layout option again! Suppose you move a few panels around, and then quit modo. When you restart, the panels will be where you left them. If you change your view again but select the 201 default layout option, your view will return to the adjusted state, not the default. So, selecting the 201 default layout option two times returns your view to modo’s original state.

When you see outstanding models from artists around the world, certainly many of them are created from the artists’ own creative minds. But a good majority of models begin with a sketch or photograph. This project will use background images to help you model the first object.

1. At the top-left of the modo viewport, change your view from Perspective to Front by clicking the Viewport icon. A drop-down list will appear.

2. To the right of the Viewport icon is the Viewport Style icon. Click this and, in the list that appears, select Backdrop, as shown in Figure 4.3.

3. In the backdrop panel that opens, click the Load Image icon. Choose the Glasses_Front.jpg image in the Chapter 4 folder of the Projects folder from this book’s DVD.
4. You'll see an image of a pair of simple eyeglasses appear in your viewport, as shown in Figure 4.4. The image will serve as a reference. This technique can be used for almost anything, from characters, to cars, to everyday objects.

**Tip**

One of modo's cool features is its pie menus. Although you can easily change viewport styles from the top-left corner of each viewport, there's another way to do so as well. First, press Ctrl+spacebar. A pie menu will appear. Move the mouse to the viewport you want, click, and go. Another option with this technique is to click Alt/Option and the q key to choose different selection modes. You can also press Alt/Option and the spacebar to gain quick access to Transform tools, Action Centers, falloffs, and more.

**Figure 4.3**

At the top of the modo viewport, change to a Front viewport style and select the Backdrop option to add an image to modo's background.

**Figure 4.4**

Adding an image to the backdrop allows you to model over the image as a reference.
5. The image is a bit small in the interface and, while you can adjust it, you also have the option to zoom into it. In the top-right corner of the viewport, you’ll see three small white icons—a crosshair to move the viewport, a magnifying glass to zoom in and out, and a tiny arrow to quickly change the viewport to other options. Click, hold, and drag to zoom in on the eyeglass image.

6. Using backdrop images is an excellent way to build almost any shape you want. Much of your modeling will rely on your talent and intuition to sculpt details into your objects, but the backdrop image is almost always a great way to start a project. Sometimes, though, the backdrop image you use is too dark or light, making your geometry hard to see. To adjust the backdrop image, select Adjust Backdrop Image from the View menu at the top of the modo interface, as shown in Figure 4.5.

7. Take a look at the bottom-left side of the modo interface. You’ll see a new set of tools appear under the Tool Properties heading, called Background Image 3D. If the Tool Properties panel appears to extend below your screen (you’ll see two small right arrows), move your mouse to the top of the Tool Properties window, then click and drag to slide the panel up. Figure 4.6 shows the Background Image 3D controls within the Tool Properties panel.

Tip
Whenever you select a tool, be it a box, tube, or some function, the properties for that tool will appear in this same area, under Tool Properties.
8. To adjust the backdrop image once the Adjust Backdrop Image controls are opened, click directly on the backdrop image in the viewport.
9. You'll see light-blue handles outline the image, with visible corners. You can click and drag on the corners to size the image larger or smaller, or you can click and drag the image to position it. Conversely, you can use the Center, Size, and Angle controls in the Tool Properties panel to adjust the image. For now the position of the image is fine, but it's too bright. Depending on the image, you can adjust the Contrast, Brightness, or Transparency. For this particular image, bring the Transparency setting to 50%. You can manually enter the value or click, hold, and drag the tiny arrows to the immediate right of the value. Figure 4.7 shows the adjustment.

10. Press the q key on your keyboard to turn off the Adjust Backdrop Image tool.

**Creating the Basic Lens**

Now that your backdrop image is in place, it's time to start creating the model.

1. Make sure the Tool Bar tab is selected at the top-left of the modo interface. Then, click the Basic list button, which lies vertically on the left side of the viewport. If you can’t see all of the letters in these buttons, drag the Tool Properties panel down. Figure 4.8 shows the area, with the Basic button selected and highlighted in orange. This Basic button refers to basic geometry and basic functions, such as primitive creation, rotation, transformation, and so on.
2. Click the Box icon in the Primitives list to activate the Box tool. You’ll see the Tool Properties panel at the bottom-left fill up with controls. For now, click and drag over the right lens of the backdrop image in the main viewport.

3. If you let go of the mouse, you’ll see red and green handles appear around the geometry, as in Figure 4.9.

4. Before you do anything, add some segments to this flat box. This will help you shape it. You can add segments in two ways at this point—either numerically in the Tool Properties panel at the bottom-left of the interface or, better yet, by clicking and dragging with your right mouse button. If you’re on a Mac without a right mouse button, you can hold the Apple (Command) key. If you click and hold the right mouse button and move the mouse to the right, you’ll add segments on the X axis. Moving left removes them. Create four segments; you should see three vertical lines.

Figure 4.8
Many of your models will begin with the basics; therefore, start this project by clicking the Basic button to reveal the primitive object-creation tools.

Figure 4.9
Red and green handles appear around the geometry.
5. Next, hold the right mouse button and move the mouse up to create three segments on the Y axis. You should see two lines horizontally.

6. One last setting in the Tool Properties panel: Add a Size value of about 1.8 cm to the Z axis. You can type this value into the field in the Tool Properties panel or just use .018, since the default unit of measurement in modo is meters. Once you’ve made your segments and added size to the Z axis, press the q key to turn off the Box tool. Figure 4.10 shows the box with four segments on the X and three segments on the Y. You won’t see the size added to the Z axis just yet, but you will later.

You should note that you can create segments in all of your primitives by using the right mouse button. And it should also be noted that if you turn off your tool—in this case, the Box tool—you can’t reactivate it and make the segments with the right mouse button. Instead, you would either need to rebuild the object or use modo’s other tools to subdivide your object.
7. Because the backdrop image has some grey in it and your geometry's base surface is grey, go ahead and change the view style. This will help you not only see what you're working on; you'll also have a clearer view of the backdrop image. At the top of the viewport, change the viewport style to Wireframe by clicking the selection list, which should read Texture at the moment. Figure 4.11 shows the choice.

8. At this point you can start adjusting the shape to fit the eyeglass lens. Press the t key to activate the Element Move tool. For the record, this tool is located within the Deform list, as shown in Figure 4.12.

The Element Move tool will become one of your best friends in modo. This tool allows you to literally click and drag on a vertex (point), edge, or polygon. This one-click operation will aid your modeling efforts faster than you thought possible. Selecting it and dragging over your model will automatically highlight the element, such as an edge or polygon. Now, it's a little tricky to get used to, so be patient. You might accidentally move an edge when you wanted to move a point. Don't worry, though—Command+z (Mac) and Ctrl+z (PC) will undo!

9. Begin at the top-left of the Wireframe box and, using the Element Move tool, click and drag the top-left corner vertex (point) down to match the outer rim of the eyeglass. Figure 4.13 shows the operation.

10. Remember, by using the Element Move tool, you do not need to select, move, and then deselect items. Simply click and drag the element and move on. So, repeating what you did in the previous step, move the other points on the outer edge of the box to match the shape of the eyeglass image. Figure 4.14 shows the rest of the points in place.

Figure 4.11
To view your model better and see the backdrop image, change your viewport style to Wireframe from the selection at the top-left of the viewport.

Figure 4.12
The Element Move tool is located within the Deform list.
Figure 4.13
Using the Element Move tool, clicking and dragging on the top-left point allows you to quickly move it into position based on the backdrop image.

Figure 4.14
Continuing with the Element Move tool, the outer edge points of the box are moved to match the shape of the backdrop image.

Note
You might find that when using the Element Move tool, the control handles can get in the way. These are the two or three arrows that appear when you click an element. If they get in the way, just click off of (or away from) the object to move these handles. Then, go back and click and drag the desired point, edge, or polygon. You can also use the Tool Pipe to uncheck visibility by clicking the dot under the V heading. (V stands for visibility.) However, be sure to turn visibility back on again when needed.
11. Press Ctrl+spacebar and change the viewport to a Perspective view.

12. Hold the Alt/Option key, then click and drag in the viewport to rotate it. Figure 4.15 shows the view rotated.

13. Back at the top-left of the viewport, change the view style to Shaded. This will make the geometry appear solid.

14. Press the Tab key on your keyboard. This activates Subdivision mode, and you’ll see your model smooth out. At this point, feel free to adjust the shape using the Element Move tool. When the basic shape is to your liking, save it and move forward with the tutorial. Remember to move back and forth between the Perspective view and Front view. You can use the 2 key on your numeric keypad to quickly jump to Front view.

You can see that what you’ve created so far isn’t that exciting. But, when you created the box, you added size on the Z axis. The object has depth, as you can now see.
Creating the Lens Details

You can see that using a backdrop image allows you to quickly create a general shape. From there, you can continue to use the backdrop image or go for it freestyle! This next section will show you how to create more detail in the eyeglass lens. From there, you’ll build the rest of the eyeglasses, then surface and render.

1. Zoom into the eyeglass lens by clicking and dragging the magnifying glass icon in the upper-right of the modo viewport.

2. Next, at the top of the modo interface, click the Polygons button to tell modo you want to work with polygons. When you do so, the button will be highlighted in orange.

3. From there, click on the top edge of the eyeglass lens, selecting just one polygon. You can tell that you have one polygon selected by looking at the bottom-right of the viewport. You should see how many polygons, points, or edges are selected depending on what item mode you’re using.

4. Holding the Shift key, select the polygon directly next to the polygon you’ve already selected. It can be in either direction, but make sure it’s on the edge, not on the front or back. Figure 4.16 shows the two polygons selected.

![Figure 4.16](image.png)

Select two polygons in order on the edge of the eyeglass.
Tip

One way to quickly select points, edges, or polygons is to click and drag the mouse. If you click a selection, then let go of the mouse button, holding the Shift key allows you to continue your selection. Conversely, holding the Ctrl key lets you click and deselect.

5. Now that you’ve told modo which way you will select polygons, the program selects the rest for you. Press the up arrow on your keyboard. The next polygon in succession will be selected. You can keep pressing the up arrow, or simply hold it down and the selection will continue around the entire edge. Figure 4.17 shows the full selection.

Figure 4.17

Once two polygons (or points or edges) are selected in order, you can use the up arrow to continue the selection.

This select loop feature is exceedingly handy and, as you might figure, using the down arrow deselects. Try using the right and left arrows as well, and see what happens. You’ll use these throughout the book, so take some time to get a feel for them. Remember that Ctrl+z (PC) and Command+z (Mac) will undo your selections or de-selections, so if you mess up, just undo back to where you were. And of course, save often!
6. With all the outer-edge polygons selected, press the **b** key to select the Bevel tool, which resides within the Mesh Edit tools. After you activate the tool by pressing the **b** key, look in the Tool Properties panel at the bottom-left of the interface. Click the Group Polys option. This tells modo to bevel all polygons together. If you left this option unchecked, you'd bevel each selection separately.

7. Once you check Group Polys, click and drag in the viewport. You'll see the edges of the model sharpen up, but not too much. Figure 4.18 shows the bevel.

8. Press the **q** key to turn off the Bevel tool, and then click anywhere in the viewport away from the model to deselect the polygons.

9. To create the separation between the lens and the frame, you can work with the edges. First select Edges at the top of the modo interface (to the left of where you selected Polygons) to tell modo you want to work with edges.

10. Go to the front of the lens and, as you did for your polygon selection, select two edges in order on the outer area of the front of the lens, but make sure to cross over the corner, as shown in Figure 4.19. Then use the up arrow to select the loop. Your selection should look like Figure 4.20.

11. If you rotate your view around toward the front, you can see that the selected edge is not perfectly even with the outer edge of the object itself. Now, thinking ahead, you'd want that edge to be even because one side of the edge will be the frame and the other will be the lens. So, using the Element Move tool (press **t**), adjust the edge and vertices (points) to simply shape the selection. Figure 4.21 shows how your selected edge should end up.
12. Don’t be too concerned with obtaining a perfect shape here. The idea is for you to understand the process of working with and editing points, edges, and polygons. Press the spacebar to turn off any tool you’re using, then click a blank area in the viewport to deselect the edges.

13. At the top of the modo interface, select the Polygons button to tell modo you want to work with polygons. Then, run the mouse around the front portion of the eyeglass (the area on the inside of that edge you just selected).
14. This next step is a little more advanced, but it is really easy to do. It will help you save your steps for use later. Once the polygons are selected, go to the top of the modo interface and, from the System drop-down menu, select Record Macro (see Figure 4.22). You’ll come back to this shortly. Figure 4.22 shows the selected polygons.

If you accidentally select more than you should, remember to hold the Ctrl key and click the polygon you do not want selected. This will deselect it while keeping the rest of your selections intact.

15. Making sure you’re still in Polygons mode (click the selection at the top of the modo interface), press the b key to activate the Bevel tool.

16. At the bottom-left of the modo interface, look to the Tool Properties panel, and you’ll see the bevel controls. Make sure Group Polys is selected. This will bevel all selected polygons as one.

Tip

Here’s a cool way to work in modo. With the polygons selected, hold the Ctrl key and watch the item buttons at the top of modo (Vertices, Edges, Polygons). You’ll see the Edges button change to Boundary. While still holding the Ctrl key, click that Boundary button. The current polygon selection will change to an edge selection around the boundary of what you had previously selected.
17. In the main viewport, click once. You'll see a blue and a red handle. But look more closely: The blue handle has a little arrow at the end, and the red handle has a square. If you have trouble seeing the handles, rotate the view around by clicking and dragging the viewport rotation control in the upper-right of the interface.

**Tip**

A quick way to rotate around while in Perspective view is to hold down the Alt key, then click and drag directly in the view.

18. Click and drag the red handle, making sure you're clicking directly on the square of the red handle. When you move the mouse over the handle, the handle will be highlighted. Clicking and dragging changes the Inset value. Drag the red handle to inset the selected polygons inward, about 2 cm. You can watch the value in the Tool Properties panel.

19. Now you want to bevel again, but you need to create a little more geometry. Holding the Shift key, click once in the viewport. This creates a new bevel from the selection. It essentially starts a new bevel.

20. Bevel the inset one more time by clicking and dragging the red handle to 2 mm. Figure 4.23 shows the operation.

**Figure 4.23**

Clicking and dragging directly on the red handle with the Bevel tool active insets the selected polygons.
21. This time, instead of using the red handle, click and drag directly on the blue handle. This will allow you to shift the selected polygons. Shift them in toward the eyeglass –2 mm. Figure 4.24 shows the operation.

![Figure 4.24](image)

Clicking and dragging the blue handle shifts the polygons you just beveled.

22. Again, holding the Shift key, click once on the selected polygons. This creates a new bevel.

23. Inset the new bevel by clicking and dragging the red handle to about 3 mm. And, shift them by clicking and dragging the blue handle to 3 mm as well. You’re pulling the selection out after you’ve beveled it so that it looks something like Figure 4.25.

![Figure 4.25](image)

Another bevel operation to both inset and shift the polygons helps form the lens from the frame.
24. One last time, hold the Shift key and click once on the selection to create a new bevel. Then, click and drag the red handle to inset the selection to 2.6 cm. Click and drag the blue handle to shift the selection to 5 mm. Note that the inset here is centimeters, and the shift is millimeters. Figure 4.26 shows the result.

![Figure 4.26](image)

One last bevel operation has the lens defined from the frame.

25. You’re almost there! Hold the Shift key, but this time press the right arrow on your keyboard twice. This will expand the selected polygons so that your entire lens will be selected.

26. There are other tools in modo that can help refine your geometry, which you’ll learn about throughout this book. However, try one now. On the left side of the interface, change to the Deform tools by clicking the vertical button at the left of the viewport. Then, under the Move Tools category, click the Smooth tool. (You can also select the Smooth tool by pressing Shift+S.)

27. Once the Smooth tool is turned on, click and drag on the polygons in the viewport. Watch them smooth out. Hold the mouse button down and move the mouse back and forth to see the geometry even out. Your goal here is to simply smooth out the bevel operations.

28. After you have smoothed out the selection, press the spacebar to turn off the Smooth tool. Then, click a blank area in the viewport to deselect the polygons.

29. Now go back up to the System drop-down list and uncheck the Record Macro option.

30. Save your work.
31. Now go back to the System drop-down list at the top of the interface and choose Save to File. When you selected Record Macro at the beginning of these bevel operations, modo stored your actions in a file that is currently held in memory. Save this file to a place on your hard drive so you can use it in the future.

32. Rotate the Perspective view around to the back of the eyeglass and select the area that would make up the lens, as you did previously at the beginning of your bevel steps. Figure 4.27 shows the selection.

![Figure 4.27](image)

Select the polygons on the back of the eyeglass that will make up the lens.

33. If your macro is still in memory, you can select Replay from the System drop-down menu. If not, you can simply call the macro from file (since you saved it) by selecting Run Script from the System drop-down menu or by pressing F6.

34. Once you run the script, you'll see the selected polygons quickly turn into a lens, similar to the lens you manually beveled on the front of the eyeglass. Pretty cool!

You can see how useful Record Macro can be. Think about things like windows, doors, or bottles. You can create a slew of macro scripts so that whenever you need a similar function, you can save yourself a lot of time.

**Creating the Frame**

This last modeling section will use some of the same techniques as the previous sections. You'll select polygons, bevel, and so on. There can be a lot more details with this model, but for now this will give you a good idea of how to begin creating models in modo. But before you build the frame of the eyeglasses, shape the lens.
1. Making sure that the work you’ve created is saved, click the Backdrop button from the viewport display type at the top-left of the viewport. This is the same place where you added the backdrop image earlier in the lesson. When you click Backdrop, a panel opens. Instead of loading an image this time, select the icon that says None. This will remove the image from the backdrop.

2. Next, make any changes you see fit to your model’s shape using the Element Move tool.

3. Save your work.

4. Click the Deform list of tools from the vertical listings on the left side of the interface. There, you’ll find the Bend tool under the Rotate Tools category. Select it and click to the center of your eyeglass object in the viewport where your model resides.

   What you’ll see when you click is a blue ring and a long handle sticking out. It’s a bit confusing at first, but you’ll soon realize its power. Figure 4.28 shows the tool.

   ![Figure 4.28](image)

First, the handle is your control to bend. If you look over at your Tool Properties on the left of the interface, you’ll see a setting for Action Axis Auto. If you change the axis from Z to X or Y, you’ll see the blue control ring change direction in the viewport.

5. Change the axis to Y. The ring should lay flat in the viewport. Remember, you can hold the Alt key and rotate the view around to see the workspace better. You should be working in the Perspective view.
6. Now click, hold, and drag the blue ring. You'll see the model bend, as shown in Figure 4.29.

7. The long handle sticking out of the ring with the light-colored square at the end is the falloff. Click and drag that little light-colored square around and watch what it does to your model. Essentially, it changes how much the Bend tool affects your model.

8. One last thing to try: If you click, hold, and drag in the very center of the blue ring, you'll change where the bend operation begins. modo is interactive, so you'll be able to see the effects of moving the tool around right away.

9. Figure 4.30 shows the approximate bend you should go for with your lens. A good place to position the blue control ring is toward the left side of the object. Remember, you've been modeling the right side of the eyeglasses, so this is the side that would bend around the face.

10. Press q to turn off the Bend tool, and save your work.

11. To make the rest of the frame for the glasses, rotate the view around to the back. Select the polygons within the upper corner of the object, as shown in Figure 4.31. Make sure that one polygon resides on the side of the object.

12. Under the Mesh Edit list of tools, select Extrude. Click once, and then drag the blue handle in the viewport to extrude the selection, as shown in Figure 4.32. Drag the selection about 10 cm or so. Feel free to drag the other handles to position the extrusion as you like.
13. Hold the Shift key and click again on the polygon selection. Then, drag the blue handle again to extend the eyeglass frame a little farther, about –7 cm on the Z axis. Figure 4.33 shows the seven extrusions.

Figure 4.30
Using the Bend tool, you can easily shape the right lens of the glasses.

Figure 4.31
The next phase means selecting just a few polygons in the upper-back corner of the lens.
Figure 4.32
Select the polygons on the back of the eyeglass that will make up the lens.

Figure 4.33
Once you create the initial extrusion of selected polygons using the Extrude tool, repeat the step seven times.

Note
While you have repeated the bevel steps seven times, you can also extrude one time, then change the Sides attribute in the Tool Properties to give it additional segments.
14. Now that you have the frame of the glasses extended, all that’s left is to make the loop for the ear. Back under the Deform tool list, select Bend. Click toward the back of the frame you just extruded, as shown in Figure 4.34.

15. Make sure the axis for the Bend tool is set to X by checking the setting in the Tool Properties panel on the left of the interface.

16. Make sure the falloff control is to the back of the object. Click and drag the highlighted light-blue square so that it resides slightly behind the frame. Then, click and drag on the blue handle to bend the end of the frame. Remember, you can rotate around your view, move the Bend tool, and move the falloff control handle to interactively shape the model. Figure 4.35 shows the result.

17. Press the spacebar to turn off the Bend tool, and save your work. Of course, you can add a lot more detail to the model, perhaps by beveling the edges more or cutting in small details on the frame. For now, though, you should have a good idea of how the modeling process works, as well as how to work with the tools and interface. However, there are a few more steps to complete before you texture and render this model, so keep going!

18. Rotate your view around to see the front of the model. From the Duplicate tool list, select the Mirror tool.

19. Click on the very left of the model to mirror it over. This tool (like most modo tools) is very interactive, and you can experiment by holding the mouse button down on the Mirror tool’s highlighted square and dragging it around. Figure 4.36 shows the mirrored object.
20. You’re going to use one more tool to make your model complete. Press q to turn off the Mirror tool. You should still be in Polygons mode (from the top of the interface). Then, select the polygons that make up the upper inside edge of each lens. Figure 4.37 shows the selections.
21. Under the Duplicate tool list where the Mirror tool was, you’ll also see a tool called Bridge. Select this. Then, click in the viewport. The two opposing polygons will connect. If you continue to hold the mouse button and drag, you can add segments to the bridge, giving it more detail. Add about five segments. You can view how many segments you’re adding by watching the value in the Tool Properties on the bottom-left side of the interface. Figure 4.38 shows the result.

The Bridge tool can also connect smoothly, or linearly. The default mode is Curve, which is perfect for the bridge of the glasses. You can change the mode in the Tool Properties.
22. Press q to turn off the Bridge tool, and then save your work. Press the a key to fit the model to the viewport, and admire your work.

There is more you can do here, such as selecting the edge of the new bridged area. You can easily double-click on the upper edge of the bridge, press b for bevel, and click and drag to sharpen the geometry. The same techniques can be applied to all four corners of the bridge. And, at any time you can undo your actions by choosing Undo from the Edit drop-down list or pressing Ctrl+Z (PC) or Command+Z (Mac).

Congratulations! You just completed a model in modo 201/202!

**Basic Surfacing**

As you can see, modeling in modo is pretty straightforward. What’s more, once you’re completely comfortable with the tools, you can model without thinking about what you’re doing. That is to say, you won’t worry about which tool to use or how to control the shape; you’ll just do it. But there will be much more modeling throughout the book. For now, how about adding some simple textures to this model?

1. Making sure the model you’ve created is saved, while you’re still in Polygons mode, select all of the polygons that make up the lenses, as shown in Figure 4.39.

2. Press m to call up the Polygon Set Material dialog box. Enter the name for the selected polygons as Eyeglass Lens and give them a light-blue color or something similar, as shown in Figure 4.40.
3. When you’re finished, click the OK button or press Enter (PC) or Return (Mac).

4. Now invert the selection by pressing the left bracket key ([) on your keyboard. This is the key to the right of the P key. You can also find this command under the Select drop-down menu. What this will do is deselect what’s currently selected (the lenses) and select what’s not currently selected (the frame).

5. After the Invert command, you should see only the frames for the glasses selected. Press m to again call up the Polygon Set Material dialog box.

6. As you might have guessed, give these selected polygons a material name of Frames and set the color to a color you like.

7. Press Enter (PC) or Return (Mac) or click OK to close the Polygon Set Material dialog box, and then click a blank area in the viewport to deselect the polygons.

8. Save your model!

9. At the top-left of the interface, there are two tabbed viewports. One reads Tool Bar, which is the one you’ve been working in. To the right of it is Render Settings. Select this option.

---

**Note**

Note that you are creating a material group. This is a group of polygons that you can see in the Info panel. By creating this group, modo will automatically create a mask for you in the Shader Tree that references this group of polygons. modo has also created a material for you and put it inside that mask. There is a distinction to be aware of here because you are not creating a material—you are creating a material group. It is a mask that references this group and a material inside the mask simultaneously.
10. New tools will appear, and at the top you will see a column labeled Shader Tree. Move your mouse over the edge of the column between the viewport and the tools, and a little double arrow will appear. When it does, click and drag to widen the tool area.

11. Then, in the Shader Tree, click the little arrow in front of the Render listing. You’ll see expanded settings, as shown in Figure 4.41.

12. You’ll get into the Shader Tree much more throughout the book, but this chapter will give you a quick overview to surfacing and rendering an object. Expand the EyeGlass_Lens material listing by clicking the triangle to the left of the listing.

13. After you expand the listing, you’ll see a listing labeled Material (2). Select this, and you’ll see this surface’s values below in the Render Properties panel, as shown in Figure 4.42.

Figure 4.41
The Shader Tree is a cool, complex, powerful place within modo 201/202.

Figure 4.42
Selecting the material for the eyeglass frames calls up the appropriate settings in the lower panel.
14. You're not going to change the surface too much at this point, but you will later in the book. Change the Reflection Amount to about 20%. Adjust the color if you'd like, and leave everything else alone.

15. Vertically on the right side of the Render Properties panel, you'll see Material Ref, which is the tool list you're working in now. You'll also see Material Trans. Select this.

16. In the properties that appear, change the Transparent amount to about 85%.

17. Change Refraction to about 1.3.

18. Save your work.

19. Back in the Shader Tree, select the Material:Frame listing. Click the triangle in front of the listing to expand. Select Material (2); here, you can adjust the color and other basic settings. Change the Specular Amount to 60%. Also, click on Double Sided at the bottom of the panel.

For now, these settings are just fine for the lens and frame, but if you're comfortable, adjust as you like. Remember to save often and that you can always undo to get back to a setting you inadvertently changed. The Shader Tree is an amazing new addition to modo 201/202. You'll use the Shader Tree extensively later in the book.

**Basic Rendering**

You've made it to the last point of the tutorial! Here, you'll get a quick lesson in rendering in modo 201/202. There are significant tools when it comes to rendering, all of which you'll work with throughout the book. This section will have you set up a camera, a light, and an environment.

1. Working with your previous lesson results, look to the right side of the modo interface, under the Item List. You'll see a camera listed. Click it and watch. Nothing happens!

2. It's okay that nothing happened because all you did was select the camera. Your current view is a Perspective view. Change this to a Camera view by clicking the drop-down list at the top-left of the viewport. Depending on your setup, you might see something like Figure 4.43 when switching to Camera view.

**Note**

You should get into the habit of rendering with the selected camera. However, you can render your current view. To do so, click Render Visible from the Render menu at the top of the interface. You can also just press Ctrl+F9.
3. The reason you can't see a good view of your object is because the camera is not set up. However, the camera is selected from the Item List, so all you need to do is move it in place. Hold the Alt and Ctrl keys on your keyboard, and then click and drag with the left mouse button. You're now moving the camera in and out on the Z axis. Move it in toward the model. Holding Alt/Option and using the left mouse button translates the camera around the center of the view. Basically, the camera is orbiting the object.

4. Holding the Alt and Shift keys while clicking with the left mouse button will move your camera around the X and Y axes. Holding the Alt key and clicking the left mouse button rotates the view. Work with these settings to move the camera into a comfortable view of the glasses, something like Figure 4.44. Also, holding the Alt/Option key and using the right mouse button will rotate the camera. If the bank movement becomes awkward, move the cursor toward the edge of the viewport and hold the Alt/Option key, and then use the left mouse button and drag up or down to fix.

5. Back in the Item List, click New Item. It's slightly ghosted, but it's just below the Camera listing. This will create a new object in a new layer. Your glasses will seem to disappear, but don't worry; they're just in another layer.

6. On the left side of the modo interface, change the Render Settings tab back to Tool Bar. And in the Basic list of tools, select the Box tool. This is pretty much the first step you did at the beginning of this chapter.

7. With the Box tool selected, change your view to a Top view. Draw a large flat box, as shown in Figure 4.45.
8. Change back to the Camera view, and then, in the Item List, click the eyeball icon to the left of Mesh (1), as shown in Figure 4.46.

9. You can see that the eyeglasses are now a background layer. Take a look at Figure 4.46. Mesh (2) is selected—you can determine that because a large grey bar covers the listing. Selecting the eyeball icon for other meshes on other layers makes them visible in the backdrop. Currently, the backdrop is set to Wireframe, and although you can change this, leave it as is for right now.
10. Make sure you’re in Polygons mode (from the top of the modo interface), and double-click on the flat box you created. Conversely, you can press Shift, and then click the spacebar to jump to Items selection mode. This will allow you to avoid using the Item List to select.

11. Press the w key to activate the Move tool, and then click and drag on the green handle to move the box down under the glasses, as shown in Figure 4.47.

12. You can also click and drag the blue handle to move the flat box on the Z axis. And if your box doesn’t fill your scene, press the r key to activate the Stretch tool. Click and drag on the appropriate handle to stretch the object on any axis. Clicking and dragging the center box of the Stretch tool scales it equally on all sides.

13. While the polygons are still selected for the flat box, press m to call up the Polygon Set Material dialog box. Name this selection Floor and give it a simple grey color.

14. Save your work.
15. Press F9 on your keyboard. If you’re on a Mac laptop, you might need to press Fn+F9. Figure 4.48 shows your first render.

![Render Frame](image)

**Figure 4.48**
A default render of the model you made. Nothing to write home about, but a few settings can give it a much better look.

16. At the top-left of the modo interface, select the Render Settings tab. Click the Render listing in the Shader Tree.

17. Below the Shader Tree, under Render Properties, click the Global Illumination button on the vertical list on the right side of the panel. In the panel, click the Enable button, as shown in Figure 4.49.

18. At the top of the Render Properties panel, bring the Ambient Intensity up to 0.07 to brighten the scene a little bit more.

19. In the Shader Tree, select the Directional Light listing. Expand the listing and select Light Material.

20. In the Render Properties panel below the Shader Tree, bring the Opacity to 0%. This essentially turns off the light.
21. Save your work.

22. Press F9 to render the scene again (or Fn+F9 on a Mac laptop). Figure 4.50 shows the render. It’s a bit blue, but you can fix that.

23. The reason your render has strong blue overtones is because the default environment has a blue sky. Turning on global illumination diffuses that blue color throughout your scene. Go back up to the Shader Tree and select the Environment listing. Expand the listing and select Environment Material.

24. Below the Shader Tree in the Render Properties panel, change Environment Type from 4 Color Gradient (you can see how much blue is there) to Constant. Change the Zenith color to a soft white or grey.

25. Press F9 to render again. Figure 4.51 shows the change.
Figure 4.50
Global Illumination rendering on the glasses looks more realistic than a basic light, but there is an overall blue cast to the scene.

Figure 4.51
Changing the environment color affects the overall global illumination of the scene.
Overall, the render is pretty boring. But you can see how drastic the change is from the first render, and all you did was make one change to the environment. Using a 2 Color Gradient as the Environment Type instead, you can add some warmth to the render. Figure 4.52 shows the final render with an orange-colored Nadir setting and an off-white Zenith. And, a 15% Reflection value has been added to the Floor surface.

Overall, you can get a lot more out of a simple render such as this. You can add more color and additional lights. You can also add more detail to the glasses, which would create more interest. But the goal of this chapter was to walk you through the entire modo workflow. You modeled, moved around the interface, changed views, created surfaces, worked with a camera, and rendered a globally illuminated scene. Not bad!
From this point, experiment on your own. I encourage you to put the book down and work in modo for a few hours. Try just texturing and lighting simple geometry. When you're comfortable with that, try modeling some other objects around your desk, such as a computer mouse, a monitor, or a lamp. Then, when you're ready, move through the rest of this book to learn about all modo 201/202 has to offer.